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Most users will be comfortable using the mouse to do all their work in Excel. For 
users who prefer to use the keyboard exclusively when working in Windows 
applications or for users who prefer to split the use of the mouse and keyboard 
among various tasks, Excel provides the following solutions:

 Keyboard shortcuts

 Keyboard navigation

 KeyTips

The first two functions are described next. For more on the last function, 
KeyTips, “Tipping off your keyboard,” later in this part.

You can access commands in Excel using  which are individual 
keystrokes or a combination of keys pressed simultaneously. To access the 
Print command using a shortcut, for example, you hold down the Ctrl key and 
press the P key, represented in this book as Ctrl+P. The following table lists 
some common keyboard shortcuts in Excel.
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With more than 17 billion cells in a worksheet, you need ways to move to spe-
cific cells. Fortunately, Excel provides you with many techniques to move 
around a worksheet. As always, you can use either your mouse or the keyboard 
on your navigational journeys. The following table lists the keystrokes that 
enable you to move through a worksheet.
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Rich menus have illustrative graphics, the command name, 
and in some cases a short description of what the command does.

   Don’t confuse rich menus with drop-down galleries, although 
they look similar. Menus contain related . Galleries allow you to 
choose from among a set of formats or layouts.

Most users are already familiar with this form of menu — 
a drop-down list of choices with command names (such as Copy or Insert 
Cells). Some command names have small associated icons. If you click a 
command name that ends with an ellipsis (…), Excel displays a dialog box 
that presents further choices.

 A spinner is a control with two arrows (one pointing up, the other 
pointing down) used with an input box to specify a number (height or 
width, for example.) Clicking an arrow increases or decreases the number 
in the input box. You can also enter a number in the box directly. The 
spinner control allows you to use only valid numbers.

 Contextual tabs give the Ribbon the power to expose 
most Excel features. One or more contextual tabs appear after you insert 
or select an object, such as a chart, shape, table, or picture. For example, 
after you insert a chart, three contextual tabs related to chart functionality 
appear on the Ribbon and a header labeled Chart Tools appears on the 
Excel title bar above the contextual tabs. Contextual tabs contain all the 
commands you need for working with the particular object. After you 
deselect an object, the contextual tabs (and the header) disappear.

  The general rules that govern the display of contextual tabs follow:

 • After you select an object (such as a chart, shape, or table), one or 
more contextual tabs for the object appear on the Ribbon. You must 
select a tab to display the associated commands.

 • After you insert an object, Excel displays the commands for the first tab 
of the contextual tab set for that object.

 • After you double-click an object, Excel displays the commands for the 
first tab of the contextual tab set for that object. Note that not all 
objects have this double-click capability.

 • After you select, deselect, and then reselect the object without using 
any other commands in-between, Excel displays the commands for the 
first tab of the contextual tab set for that object.

 In addition to the built-in standard and contextual Ribbon 
tabs that Excel includes, you can create custom Ribbon tabs.
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It is important to note that at each stage of downward resizing, no command 
groups or commands disappear entirely from the Ribbon. The multiple layout 
options for the command groups ensure that nothing is lost as space becomes 
more limited. If you reduce the size of the Excel window sufficiently, however, 
the Ribbon disappears altogether.

Excel provides KeyTips, which allow you to access every command on the 
Ribbon using the keyboard, without having to memorize keystroke combinations! 
So, what are KeyTips? s are little alphanumerical indicators containing a 
single letter, a single number, a combination of two letters, or a combination of a 
letter and a number, indicating what to type to activate the command under 
them, as shown in Figure 1-5.

 

Follow these steps to access a command on a Ribbon tab using a KeyTip:

Press the Alt key. The KeyTips appear over the Ribbon tabs. (Ignore the 
KeyTips that appear in the other areas of the user interface for this 
exercise.)

Press the key that represents the KeyTip for the Ribbon tab that you want 
to access. For example, press N to select the Insert tab. Note that you 

 have to hold down the Alt key. If you need to select a different tab 
after you select the KeyTip for a tab, press the Esc key.

Press the key or key combination that represents the KeyTip for the 
command you want to use.

If the command you select is a drop-down gallery or drop-down grid, you can 
use an arrow key or the Tab key to highlight your choice and then press the 
Enter key to select your choice.

 KeyTips are associated with in-Ribbon galleries, so you have to press 
the key that represents the KeyTip for the gallery before you can choose an 
option in the gallery.

If you find that the Ribbon commands take up too much room in the Excel 
window, you can hide them using any of the following methods:
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Click the Ribbon’s Minimize button in the Excel title bar (to the left of the 
help button)

Press Ctrl+F1

Double-click any Ribbon tab

Right-click in the Ribbon area and choose Minimize the Ribbon from the 
contextual menu

After you hide the commands, only the Ribbon tabs are displayed. If you click a 
tab after you hide the Ribbon commands, Excel displays the tab commands 
temporarily. The commands are hidden again after you select a command in the 
tab or click away from the Ribbon area. Similarly, you can use KeyTips to select 
a command when the command display is hidden.

To redisplay the commands permanently after you hide them, use the same 
methods described for hiding the commands.

 Excel maintains the hidden condition of the Ribbon commands if you 
exit and subsequently relaunch Excel.

The Quick Access toolbar (or QAT) is an area of the user interface that provides 
quick access to commands. The QAT is designed to reduce the amount of 
navigation you have to do in the Ribbon to access the features that you use 
frequently. The QAT is located at the top left of the Excel title bar, above the 
Ribbon tabs (see Figure 1-6).

 

The QAT contains three default commands (Save, Undo, and Redo); you can add 
additional commands.

Follow these steps to add a command to the QAT:

Select the Ribbon tab that houses the command you want to add.

Right-click the command and choose Add to Quick Access Toolbar in the 
menu that appears.

 

 To quickly add some commonly used commands to the QAT, click the arrow to 
the right of the toolbar and choose a command from the menu.
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 “Arranging Windows Automatically” and “Comparing Two Documents 
Side by Side,” both earlier in this part.

 A single workbook can have as many views (that is, separate 
windows) as you want.

  Displaying multiple windows for a workbook also makes copying information 
from one worksheet to another easier. You can use Excel’s drag-and-drop 
procedures to copy a cell, a range, or a chart.  “Copying Cells and 
Ranges,” in Part 4, and “Resizing, Moving, Copying, and Deleting an Embedded 
Chart,” in Part 10.

In addition to files in its native format, Excel can open files in non-native Excel 
2010 formats, including older Excel and text files. Excel can open files that 
weren’t saved in its native format by using filters to open the foreign file as a 
workbook document.

To open a file in a non-Excel 2010 format, follow these steps:

Click the File tab on the Ribbon and then choose Open. Excel displays the 
Open dialog box.

Windows XP: In the Files of Type drop-down list, select the file type.

  Windows Vista and Windows 7: Click the button located above the Open 
and Cancel buttons and choose a file type from the menu. By default, the 
button text reads All Excel Files (*.xl*;*.xlsx;*.xlsm), but the text changes 
if you select a different file type.

Windows XP: In the Look In drop-down list, navigate to the folder that 
contains the file.
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  Windows Vista and Windows 7: In the Folders window on the left side of 
the dialog box, navigate to the folder that contains the document.

Select the file and click Open, or double-click the filename.

 “Opening a Workbook,” immediately following this section.

If you open a workbook in Excel, the entire document loads into memory, and 
any changes that you make occur only in the copy that’s in memory. During the 
file open process, the workbook undergoes security checks. If Excel detects a 
potential security issue, it will open the workbook in one of two ways:

After opening the workbook, a security warning message is displayed in 
the Message bar. Security warnings appear if Excel detects  content 
in the workbook. The most common active content you’re likely to encounter 
are macros, ActiveX components (a type of software code), and external 
data connections.

Excel opens the workbook in protected mode. In  you can 
view but not edit the contents of the workbook (it’s read-only and all 
Ribbon controls are disabled). Also, Excel places the workbook in an 
isolated environment so that any malicious code present cannot get into 
your system and cause harm. In general, Excel opens the workbook in 
protected mode if it detects any the following conditions:

 • The workbook was downloaded from the Internet. Windows places a 
marker on a file you download from the Internet, identifying its source.

 • The workbook was opened from Outlook 2010.

 • The workbook was opened from an unsafe location, such as your 
Temporary Internet Files folder.

 • The workbook was blocked by Excel’s File Block policies.

 • The workbook fails file validation checks. Excel validates binary files 
(Excel files with an .xls or .xlt extension) against a well-known structure 
(called a ). You can change Excel’s default handling of files with 
security issues by modifying settings in the Trust Center.  
“Modifying security settings in the Trust Center,” later in this section.

To open a workbook, follow these steps:
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were lost. In Excel 2010, if you close the workbook without saving changes, Excel 
retains the last autosaved version of the workbook, so you can recover your 
changes up to the last time AutoRecover saved the workbook. To open this 
version of the workbook, go Backstage and select the file on the Recent tab. The 
file has the following added descriptive label: .

 

Excel 2010’s Backstage view consolidates all workbook properties, such as the 
workbook’s location, author, and title, and when the workbook was created and 
last modified.

Click the File tab on the Ribbon to go to the Backstage view, and then click the 
Info tab in the Backstage navigation pane if it isn’t already selected. At the top of 
the Info tab, Excel provides the full file path of the workbook. You can explore 
the options available for Permissions, Prepare for Sharing, and Versions by 
clicking the appropriate button and choosing an option from the menu.

The right side of the tab contains the following document-related categories:

 Displays a list of document information, most of which you can 
change by clicking the text box next to the property name. For example, to 
add a title, click the text that displays Add a title. Clicking the text exposes 
a text box in which you can enter a title. Click the Show All Properties link 
to display additional options.

 Displays a list of dates related to the document — the 
create date, the date last modified, and the date last printed.

 Displays a list of one or more authors who contributed to 
the document and the person who last modified the file. You can add a 
person to the list of authors. If other authors are in your Contacts list, you 
can click an author’s name and select a contact method, if you need to 
contact the author.

 Click the Open File Location button if you want to 
open other workbooks stored in the same location as the active workbook.

When you save a workbook, Excel saves the copy in memory to your drive — 
overwriting the previous copy of the workbook. When you save a workbook for 
the first time, Excel displays its Save As dialog box.
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Click the File tab on the Ribbon and then click Save As. Excel displays the 
Save As dialog box.

In the Save As Type drop-down list, select the format in which you want to 
save the file. For example, to save in an earlier Excel file format, select 
Excel 97-2003 Workbook.

Click Save.

 “Sharing Workbooks,” next in this part.

 If you attempt to save a workbook with features not supported in the 
file format you’re saving to, Excel displays a warning message. If the format 
you’re saving to is an earlier version of Excel, Excel displays the Compatibility 
Checker dialog box, which shows you a list of features that will be lost.

After you create and save a workbook you may want to share the workbook. If 
you’re sharing the workbook with others in your internal computer network, 
you can simply save the file to a shared server folder with appropriate 
permissions set for users accessing the file.

Excel provides other methods to share a workbook, such as e-mailing it or 
saving it to SharePoint. Follow these steps to share a workbook:

Click the File tab on the Ribbon and then click the Save & Send tab in the 
Backstage navigation pane. The Save & Send tab contains additional tabs 
arranged in two categories: Save & Send and File Types. File Types provides a 
convenient list of common file types to which you can save your workbook 
before sharing.

Click a tab in the Save & Send category and select an option on the tab. For 
example, if you want to e-mail a file, click the Send Using E-mail tab and 
then click an e-mail option on the right side of the tab.

If you have multiple workbooks open, they usually appear maximized on-screen 
so that you can view only one workbook at a time.

To switch the active display among workbooks, use one of the following methods:

Click the View tab on the Ribbon, click the Switch Windows button, and 
then select one of the workbook names on the menu that appears.

04_527559-ch02.indd   3504_527559-ch02.indd   35 4/1/10   7:00 PM4/1/10   7:00 PM









A workbook can consist of any number of  Each sheet has a tab that 
appears at the bottom of the workbook window. In this part, we discuss several 
useful things that you can do with worksheets.
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Before you can do any work in a worksheet, you must first activate it. To  
a worksheet, just click its tab. If the tab for the sheet that you want to activate 
isn’t visible, use the tab scrolling buttons to scroll the sheet tabs. Figure 3-1 
shows how Excel highlights the active sheet. You also can use the following 
shortcut keys to activate a different sheet:

 Activates the previous sheet, if you have one.

 Activates the next sheet, if you have one.

 Tab scrolling buttons

Active worksheet highlighted

You can add a new worksheet to a workbook in the following ways:

 Click the Insert Worksheet tab button, which is located after the last 
worksheet tab in the workbook.

Right-click any sheet tab, choose Insert from the menu, and click 
Worksheet in the Insert dialog box. Click OK to insert the new worksheet.

On the Ribbon’s Home tab, click the arrow portion of the Insert button, 
and then choose Insert Sheet from the menu.

Press Shift+F11.

In each case, Excel inserts a new worksheet and it becomes the active worksheet. 
The default name that Excel gives to the worksheet is the word  followed 
by a number (for example, Sheet1, Sheet2, and so on).

By default, Excel names its worksheets Sheet1, Sheet2, and so on. Providing more 
meaningful names helps you identify a particular sheet. To change a sheet’s name:
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Provide a password in the Protect Sheet dialog box, if you want.

 • If you enter a password, you must reenter the password before the 
sheet can be unprotected.

 • If you don’t supply a password, anyone can unprotect the sheet.

In the Allow All Users of This Worksheet To list box, click the appropriate 
check boxes to select the elements that users can change after the sheet 
is protected.

Click OK.

By default, the locked property is turned on for all cells and objects, 
which means that they are locked when you protect the worksheet. Before 
protecting a worksheet, you normally want to unlock the input cells (the cells in 
which you enter data). To lock or unlock cells, first select them, and then right-click 
and choose Format Cells from the contextual menu; then check or uncheck the Lock 
check box on the Protection tab.  “Selecting Cells and Ranges,” in Part 4.

To remove protection from a protected sheet, right-click the worksheet you 
want to unprotect and choose Unprotect Sheet from the contextual menu, or 
click the Review tab on the Ribbon and click the Unprotect Sheet button. If the 
sheet was protected with a password, you have to enter the password before 
you can unprotect the sheet.

Splitting an Excel window into two or four panes enables you to view multiple 
parts of the same worksheet. Some of the key features of splitting panes are as 
follows:

 Clicking the View tab on the Ribbon and then clicking the Split button 
splits the active worksheet into two or four separate panes.
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This part deals with two of the most common tasks you’re likely to perform on a daily 
basis in Excel: entering data into worksheet cells and editing (or changing) the data after 
you enter it. Excel provides many handy tools to make these tasks painless and efficient.

 

06_527559-ch04.indd   4906_527559-ch04.indd   49 4/1/10   7:01 PM4/1/10   7:01 PM





Paste Options
gallery on
the Ribbon

Paste Options gallery
on the right-click menu

Paste Options
gallery in the

Smart Tag

Move the cell pointer to the cell that you want to copy (the source cell).

 Click the Copy button on the Ribbon’s Home tab. (You can also press 
Ctrl+C or right-click the cell and choose Copy from the contextual menu.)

Select the cell or range that you want to hold the copy (the destination 
cell or range).

 To select the default paste operation, click the top part of the Paste split 
button on the Ribbon’s Home tab. Alternatively, you can press Ctrl+V or 
right-click the destination cell or range and choose the leftmost icon 
immediately below the Paste Options label on the contextual menu.

  To select another paste option, click the arrow part of the Paste split 
button, and hover the mouse cursor over the icons in the gallery to 
preview your choices. In addition to the live preview, Excel displays a 
ScreenTip for each icon that provides descriptive text to help you with 
your choice.

  As an alternative to using the Paste button on the Ribbon to select 
another paste option, you can right-click the destination cell or range and 
hover over the available choices in the contextual menu. The menu displays 
the most common paste options. To view additional choices, select Paste 
Special and hover over the options in the flyout gallery.
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In certain circumstances, you may want to delete entire rows or columns from 
your worksheet. If you delete a row(s), the rows below the deleted row(s) shift 
upward to fill the gap. If you delete a column(s), the columns to the right of the 
deleted column(s) shift to the left to fill the gap.

To delete entire rows or columns, follow these steps:

Select the row header or column header of the row or column you want to 
delete.  “Selecting entire rows and columns,” later in this part. Excel 
selects the entire row or column.

Use any of the following methods to delete the row or column:

 • Right-click the selected row or column and choose Delete from the con-
textual menu.

 • Press Ctrl+– (the minus sign).

 • Click the upper portion of the Delete button on the Ribbon’s Home tab 
(the portion above the button’s name).

 

 Make sure that any cells that you want to keep aren’t in the rows or columns 
you delete. You can zoom out in your worksheet to check for any cells that 
aren’t normally visible on-screen.  “Zooming a Worksheet,” in Part 3.

After you enter information into a cell, you can edit it. To edit the contents of a 
cell, use one of the following ways to get into cell-edit mode:

Double-click the cell to edit the cell contents directly in the cell.

Click the cell and press F2 to edit the cell contents directly in the cell.

Click the cell that you want to edit; then click the formula bar to edit the 
cell contents in the formula bar.

All these methods cause the formula bar to display two new mouse icons. The 
following table describes these icons and what they do.
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As you enter a formula, Excel shows each cell reference in the formula in a different 
color. If the reference cells are visible on the worksheet, you see a border around 
each cell in the same color as the cell reference in the formula. This feature makes it 
easier to identify the references of the cells you’re typing in your formulas.

 “Entering formulas by pointing,” immediately following in this section.

  If you find the Formula AutoComplete feature distracting, or you simply want to 
disable it temporarily, follow these steps to turn off the feature:

Click the File tab, and then click the Options button.

In the Excel Options dialog box, click the Formulas category.

In the Working with formulas section, deselect the Formula AutoComplete 
check box.

Click OK.

The pointing method of entering a formula still involves some manual typing. 
The advantage is that you don’t need to type the cell or range references. 
Instead, you point to them in the worksheet using the mouse or the arrow keys, 
which is usually more accurate and less tedious.

The best way to explain this procedure is with an example. Follow these steps to 
enter the formula  into cell A3 by using the pointing method:

In cell A1, type  and press Enter. In cell A2, type  and press Enter.

Move the cell pointer to cell A3 (by clicking the cell or navigating with the 
arrow keys). This cell is where you want the formula (and the result) to go.

Type an equal sign ( ) to begin the formula.

Click cell A1 or press the up-arrow key twice. Note that Excel displays a 
moving border around the reference cell (A1) and the cell reference 
appears in cell A3 and in the formula bar (see Figure 4-5).

 

  Excel colors the cell reference in the formula and the moving border 
around the reference cell (A1) with the same color.
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If you want to keep multiple lines of a cell’s content in view on the formula bar, 
you can adjust the height of the formula bar by dragging the resize bar at the 
bottom of the formula bar. As you drag the resize bar downwards, the worksheet 
grid is pushed down to accommodate the expanded formula bar. Clicking the 
Auto expand/collapse button at the far right of the formula bar (or pressing 
Ctrl+Shift+U) toggles between a single-line display and an expanded-line display 
(based on the last drag setting.)

 

Auto expand button

Resize cursor Resize bar Scroll arrows

 To display a long text entry that’s adjacent to a cell that contains an 
entry, you can edit your text to make it shorter, increase the width of the 
column, or wrap the text within the cell so that it occupies more than one line. 

 “Modifying Cell Size,” in Part 8.

If you’re entering a lot of repeated text entries into a column, AutoComplete can 
help you speed up the process. You type the first few letters of a text entry into 
a cell, and Excel automatically completes the entry based on other entries 
you’ve made in the column. Your column entries must be contiguous (that is, 
have no blank cells between entries). AutoComplete doesn’t work with entries in 
a row.

AutoComplete works with no effort on your part; just follow these steps:

Begin entering text or a value. If Excel recognizes your entry, it automatically 
completes it.

If Excel guesses correctly, press Enter to accept it. To enter something 
else instead, just continue typing and ignore Excel’s guess.

  You can access this feature also by right-clicking the cell and choosing Pick from 
Drop-down List. If you use this method, Excel displays a list of all the entries in 
the current column. Just click the one you want, and Excel enters it 
automatically.

 AutoComplete works only with pure text or mixed text (text and 
values); it doesn’t work with pure values.
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To have Excel search and replace all occurrences automatically, click the 
Replace All button. To verify each replacement instead, click the Find 
Next button. Excel pauses after it finds a match. To replace the found text, 
click Replace. To skip it and find the next match, click the Find Next 
button again. Click the Find All button to select a match from the drop-
down window.

Click the Close button after you finish finding and replacing the text.

 “Finding Specific Data,” in Part 7.

In Excel, you normally select a cell or range before performing an operation that 
works with the cell or range. Topics in this section describe how to make various 
types of cell and range selections.

 Many dialog boxes in Excel provide a special text box called a  
box, which allows you to enter or point to a range. When a dialog box includes a 
RefEdit box, you can choose to select the range in advance or after you display 
the dialog box. You encounter RefEdit boxes (although we may not explicitly 
refer to them as such) in various procedures we describe in this book.

To select a cell (and make it the active cell), use any of the following techniques:

Use the arrow keys to move the cell pointer to the cell.

Click the cell with the mouse pointer.

Click the Find & Select button on the Ribbon’s Home tab and choose Go To 
from the menu (or press F5 or Ctrl+G), enter the cell address in the 
Reference text box of the Go To dialog box that appears, and click OK.

The selected cell now has a dark border around it, and its address appears in 
the name box.

 

 You can select a range in any of the following ways:

Click the mouse in a cell and drag to highlight the range. If you drag past 
the end of the screen, the worksheet scrolls.

Move to the first cell of the range. Press F8, and then move the cell pointer 
with the direction keys to highlight the range. Press F8 again to return the 
arrow keys to normal movement.
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Click the row or column heading to select a single row or column.

To select multiple adjacent rows or columns, click a row or column 
heading and drag to highlight additional rows or columns.

To select multiple (nonadjacent) rows or columns, press Ctrl as you click 
the row or column headings that you want.

Press Ctrl+spacebar to select the column of the active cell or the columns 
of the selected range.

Press Shift+spacebar to select the row of the active cell or the rows of the 
selected cells.

Click the Select All button at the intersection of the row and column headers, 
or press Ctrl+A or Ctrl+Shift+spacebar to select all cells in the worksheet. 
Selecting all cells is the same as selecting all columns and all rows.

An Excel workbook can contain more than one worksheet, and a range can 
extend across multiple worksheets. You can think of these as three-dimensional 
ranges.

To select a multisheet range, follow these steps:

Select a cell or range on the active sheet.  “Selecting a range,” earlier in 
this part.

Group the sheets that will be in the range.  “Grouping and Ungrouping 
Worksheets,” in Part 3.

After you select a multisheet range, you can perform the same operations that 
you can perform on a single sheet range. Any changes that you make to one 
sheet (formatting, entering or editing data, and so on) are reflected in the other 
sheets.

If you need to change the orientation of a range, Excel can do it for you in a 
snap. After you transpose a range, the data that was in rows is transferred to 
columns and vice versa. Figure 4-10 shows an example of a horizontal range that 
we transposed to a vertical range.
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The transpose operation is nothing more than a special paste option. To 
transpose a range, therefore, follow the steps outlined in “Copying a range to 
another range,” earlier in this part, but in Step 4, select the Transpose option 
from the Paste Options gallery. Ensure that the transposed range doesn’t 
overlap the nontransposed range.

After you transpose a range, delete the original range if required.

Excel adjusts any formulas in the original range so that they work 
correctly after you transpose them.

One very useful feature in Excel is its multilevel Undo feature. This feature 
enables you to reverse your recent actions, one step at a time. If you discover 
that you accidentally deleted a range of data several minutes ago, for example, 
you can use the Undo feature to successively undo your actions until the 
deleted range reappears.

To undo an operation, use any of the following techniques:

 Click the undo button on the Quick Access toolbar until you arrive at the 
action that you want to undo.

Press Ctrl+Z until you arrive at the action that you want to undo.

Click the arrow on the undo button on the Quick Access toolbar. This 
action displays a description of your recent actions. Select the actions that 
you want to undo.
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 • A Custom validation. You can enter a Boolean formula (a formula that 
returns a True or a False value) to specify a validation rule. If the formula 
returns False, the validation rule is invoked. For example, if you specify 
a data validation entry range in a column that starts at cell A2, the 
formula  ensures that each value entered in the range is greater 
than the value above it. (Excel automatically adjusts the validation 
reference for each cell in the range, so for cell A3 the formula is 

, and so on.)

To specify a message to appear after a user clicks an input cell, click the 
Input Message tab and type a message in the Input Message text box. If 
you want a title to appear at the top of the message, enter a title in the 
Title text box.

To specify a custom error message to appear in a dialog box if someone 
enters invalid data, click the Error Alert tab and type a message in the 
Error Message text box. If you want a title to appear at the top of the 
message, enter a title in the Title text box.

  Choose a style for the error message from the Style drop-down list box 
(Stop, Warning, or Information). Each style that you select displays an 
error icon and various buttons on the error dialog box as follows:

 • Stop: Displays Retry and Cancel buttons.

 • Warning: Displays Yes, No, and Cancel buttons. (Clicking Yes enters the 
invalid data.)

 • Information: Displays OK and Cancel buttons. (Clicking OK enters the 
invalid data.)

Click OK.

If you subsequently want to remove the validation criteria from a cell or range, 
select the cell or range, click the upper portion of the Data Validation split 
button on the Ribbon’s Data tab, and click the Clear All button in the Data 
Validation dialog box that appears.

 If you don’t specify a message in Step 5, Excel uses a default message 
if a data-entry error occurs.

  You can combine data validation with worksheet protection to permit only 
validated input cells to be altered.  “Protecting a Worksheet,” in Part 3.
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 If you want to retain the current values (not formulas) from 
one or more source workbooks, and you no longer want to link to the 
source(s), you can break the links to the source workbook(s).

  In the window, select the workbook(s) with which you want to sever the 
links and click Break Link. Because you cannot undo the operation, Excel 
prompts you for confirmation. Click Break Links in the confirmation 
message box to permanently break the links.

Whenever you open the Edit Links dialog box, the Status 
column in the window displays as . Excel doesn’t automatically 
display the current status of links.

  Click the Check Status button to see the current status of links. A status of 
, , or  indicates 

that no action is required on the user’s part. However, if the status displays 
a warning or error message for a source workbook, the user must update 
the values, change the source, or open the source. The specific error or 
warning message indicates the required action.

  By default, when you open a workbook containing 
external references (the destination workbook), Excel prompts you to 
update links if any source workbooks are not already open. (Links are 
updated automatically when source workbooks are open.) However, you 
can control the prompting and updating behavior when opening a workbook.

  Click the Startup Prompt button. Excel displays a dialog box with the 
following three choices:

 •  After selecting this option, the 
user must then turn the alert display on or off as follows: Click the File 
tab and then click the Options button. In the Excel Options dialog box, 
click the Advanced category and scroll down to the General section. 
Finally, select or deselect the Ask to Update Automatic Links check box.

  If you deselect the check box, Excel automatically updates the links 
without displaying a prompt when you open a dependent workbook. 
Note that this option affects the  user only and applies to every 
dependent workbook that the current user opens. The option does not 
affect any other user with whom you share the workbook.

 • . This option is 
self-explanatory and affects all users with whom you share the 
workbook.

 • . This option is self-explanatory, 
and affects all users with whom you share the workbook.
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In the Find What drop-down list box, enter the characters to search for. 
You can use the list also to select items that you previously searched for.

If you want to make your search case-sensitive, select the Match Case 
check box. If the Match Case check box isn’t visible, click the Options 
button.

To search for data with specific formatting:

 a. Click the Format button. (If the Format button isn’t visible, click the 
Options button.) Excel displays the Find Format dialog box.

 b. Click the appropriate tabs, and in each tab, specify the formatting that 
you’re looking for.

 c. After you complete your selections, click OK.

   If a cell in your worksheet already contains all the formatting you want to 
use in your search, click the arrow on the Format button and select 
Choose Format From Cell. Excel adds an eyedropper icon to the cursor. 
Click the cell with the required formatting.

In the Within drop-down list box, select whether you want to look in the 
active sheet or the entire workbook. (If the Within drop-down box isn’t 
visible, click the Options button.)

In the Search drop-down box, select the direction that you want to search, 
as follows:

 • Select By Rows to search across rows.

 • Select By Columns to search down columns.

   In most cases, your search goes faster if you select By Columns.

In the Look In drop-down list box, specify what to look in: Formulas, 
Values, or Comments.

Click the Find Next or Find All button. If you click Find Next, Excel selects 
the cell that contains what you’re looking for. If you click the Find All 
button, Excel displays a drop-down window that shows all references to 
the found data, either in the active worksheet or across the entire work-
book, depending on your selection in Step 5. Click a reference in the 
window to go directly to that cell.

Click the Close button to end your search.

  For approximate searches, use  An asterisk represents any 
group of characters in the specified position, and a question mark represents 
any single character in the specified position. If you type , for example, 
those letters represent all text that begins with  and ends with  Similarly,  
matches three-letter words such as  and 
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Excel’s auditing tools can help you track down errors in your worksheet by 
drawing arrows (known as ) to precedent and dependent cells. A 
cell’s   are cells that are referenced in the cell’s formula. An 

 is a cell that isn’t used directly in the formula but is used by 
a cell that you refer to in the formula. A cell’s  are formulas that 
reference the particular cell, either directly or indirectly.

To trace the precedents or dependents of a cell, follow these steps:

Click the cell that you want to trace.

Click the Formulas tab on the Ribbon and do one of the following:

 • Click the Trace Precedents button in the Formula Auditing group. Excel 
draws arrows from all  precedent cells.

 • Click the Trace Dependents button in the Formula Auditing group. 
Excel draws arrows to all  dependent cells. See an example in 
Figure 7-7.

 

Repeat Step 2 (click the Trace Precedent or Trace Dependent button) 
as often as necessary to draw arrows to  precedent or  
dependent cells.

Double-click an arrow to move the cell pointer to a precedent cell or a 
dependent cell. If Excel displays a dashed line pointing to a miniature 
sheet icon, the precedent cells are on a different worksheet. Double-
clicking the dashed line displays the Go To dialog box. Click a cell 
reference in the Go To dialog box and then click OK.

Click the Formulas tab on the Ribbon (if necessary) and then click the 
Remove Arrows button in the Formula Auditing group after you finish 
tracing the source of your error.
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 A single error value can make its way to lots of other cells that 
contain formulas that depend on the cell.

“Tracing formula error values,” earlier in this part.

The Excel Cell Comment feature enables you to attach a comment to a cell. 
Comments are useful for documenting a particular value, providing input 
instructions for users, or helping you remember what a formula does. After you 
move the mouse pointer over a cell that has a comment, the comment appears 
in a small box (see Figure 7-8).
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To add a comment to a cell, follow these steps:

Select the cell.

Click the Review tab on the Ribbon and then click the New Comment 
button. (You can also right-click the cell and choose New Comment from 
the contextual menu, or press Shift+F2.)

In the text box, enter the text for the comment.

After you finish, click any cell.

The cell displays a small red triangle to indicate that it contains a comment.

To edit a comment, follow these steps:

Select the cell containing the comment.

Click the Review tab on the Ribbon and then click the Edit Comment 
button. (You can also right-click the cell and choose Edit Comment from 
the contextual menu, or press Shift+F2.)

Edit your comment in the text box displayed.

After you finish, click any cell.

Cells to which you attach a comment display a small red triangle in the 
upper-right corner. After you move the mouse pointer over a cell that contains 
a comment, Excel displays the comment.
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You have a lot of control over the appearance of information that you enter into a 
cell. Changing the appearance of a cell’s content is known as  Formatting 
data in a range can make your worksheet more readable and presentable. In this 
part, you discover how to apply Excel’s many formatting options.
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  Click the Font Color button to apply the color that the button 
displays to the font in your selected cell or range. Click the arrow on the 
button to choose a color from the color palette.

  Click the Background Color button to apply the cell back-
ground color that the button displays. Click the arrow on the button to select 
a color from the color palette.

 If you choose fonts or colors that are part of a theme, the fonts or 
colors change if you change the workbook theme. “Formatting with 
Themes,” in Part 1 for a discussion of theme fonts and colors and “Using Cell 
Styles,” later in this part.

 

 The quickest way to copy the formats from one cell to another cell or range is to 
use the Format Painter button on the Ribbon’s Home tab. Follow these steps:

Select the cell or range with the formatting attributes that you want to 
copy.

 Click the Format Painter button. Note that the mouse pointer appears as a 
miniature paintbrush.

Select (paint) the cells to which you want to apply the formats.

Release the mouse button, and Excel copies the formats.

  Double-clicking the Format Painter button causes the mouse pointer to remain a 
paintbrush after you release the mouse button. This paintbrush enables you to 
paint other areas of the worksheet with the same formats. To exit paint mode, 
click the Format Painter button again (or press Esc).

In addition to applying static formatting to your worksheet cells and ranges, you 
can format a cell or range based on the contents of the cell or range. Using 
Excel’s  feature, you can format one or more cells based on 
the values in the cells, or you can format a range based on the relative values of 
the cells in the range. You may, for example, want to visually identify all cells in 
a range that exceed a certain value or you may want to highlight cells in a range 
having duplicate values.

10_527559-ch08.indd   12110_527559-ch08.indd   121 4/1/10   7:21 PM4/1/10   7:21 PM





In the dialog box that appears (see Figure 8-2), enter a value (or values in 
the case of Between) in the box on the left. (The label for this box changes 
depending on what you chose in Step 3.) Instead of entering a value in the 
Format Cells That Are box, you can click the mouse pointer in the box and 
point to a cell on the worksheet.

 

If you see a formatting option you like in the drop-down list on the right, 
select the option and then click OK to apply the conditional format.

If you don’t like any of the available formatting options:

 a. Select Custom Format at the bottom of the drop-down list. Excel dis-
plays the Format Cells dialog box.

 b. Select your formatting options on the Number, Font, Border, and Fill 
tabs as appropriate.

 c. Click OK to close the Format Cells dialog box, and then click OK again 
to apply the conditional format.

 If the cell doesn’t meet the condition that you specify, it takes on the 
standard formatting for the cell.

  If you copy a cell containing conditional formatting, the conditional formatting 
applies to all copies.

Excel 2010 provides several criteria that you can use to format cells based on a 
comparison of the cell values in a range. You can format cells in a range based on

Duplicate or unique values

Top  items (values), where  is a number you specify

Top % rank, where  is a number you specify

Bottom  items (values), where  is a number you specify

Bottom % rank, where  is a number you specify

Above average values
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 To quickly delete (clear) all conditional formatting rules for a cell or range, 
select the cell or range, click the Conditional Formatting button on the Ribbon’s 
Home tab, choose Clear Rules from the menu, and then choose Selected Cells 
from the flyout menu. To quickly delete (clear) all conditional formatting rules 
for the active worksheet, choose Entire Sheet from the Clear Rules flyout menu.

Excel internally stores all numbers and dates that you enter in your worksheet 
as plain, unformatted numbers. You can use Excel’s built-in numeric and date/
time formats to make your data more readable and understandable. In addition, 
if you can’t find a suitable built-in format to fit your needs, you can create a 
custom number format.

Excel is smart enough to perform some number formatting for you automati-
cally. If you enter  into a cell, for example, Excel knows that you want to use 
a percentage format and applies it for you automatically. Similarly, if you use 
commas to separate thousands (such as ) or a dollar sign to indicate 
currency (such as ), Excel applies the appropriate formatting for you.

Use the buttons in the Number group on the Ribbon’s Home tab to quickly apply 
common number formats. After you click one of these buttons, the active cell 
takes on the specified number format.

  You can select among several currency symbols by clicking the arrow on the 
Accounting Number Format button in the Number group on the Ribbon’s 
Home tab and choosing a symbol from the menu.

To access additional number formats, click the arrow on the Number Format 
drop-down list above the number format buttons and select an option from the 
list.

If none of the predefined number format buttons or Number Format list options 
fit the bill, you need to use the Format Cells dialog box. Follow these steps to 
select an option from the Format Cells dialog box:

Select a cell or range of cells you want to format.

Click the arrow on the Number Format drop-down list and select More 
Number Formats at the bottom of the list; or click the Number dialog 
launcher button at the bottom right of the Number group container. Excel 
displays the Format Cells dialog box with the Number tab selected.
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Select display options depending on the type of visualization you selected 
in Step 5 (Data bar, Color scale, or Icon set):

   Select bar appearance options from the appropriate drop-
down boxes. You can change Fill (gradient or solid), Color, Border (no 
border or solid border), Border Color (for solid border), and Bar 
Direction (context, left-to-right, or right-to-left).

  Click the Negative Value and Axis button to display the Negative Value 
and Axis dialog box. From here, you can change the fill color and 
border color for negative value bars, and the position of the axis in the 
cells, which is used to delineate negative and positive value bars. You 
can choose to display no axis, in which case both positive and negative 
bars are in the same direction (not the best choice in most cases). Click 
OK to return to the previous dialog box.

   Select colors for the lowest, highest, and midpoint values 
(3-color scale only).

  Choose a “base” set from the Icon Style drop-down gallery. If 
you want to change the icon display choice for a value rule, click the 
appropriate Icon drop-down arrow on the left of the appropriate rule. 
Next select a new icon from the gallery, or select No Cell Icon.

  If you want to display data bars or icons in the selected range without the 
associated values, select the Show Bar Only or Show Icon Only check box 
(available after you choose a data bar or icon set format style, 
respectively).

Click OK to return to the Rules Manager dialog box, and then click OK to 
exit and apply your changes.

You can hide the contents of a cell by using either of the following formatting 
options:

Apply a custom number format consisting of three semicolons ( ).  
“Creating custom number formats,” earlier in this part.

Make the text color the same as the background color.  “Changing the 
Appearance of Cell Contents,” earlier in this part.

Both formatting techniques have the same flaw: If the active cell pointer is on the 
cell, its contents are visible in the formula bar. To avoid this flaw and make the 
cell contents truly invisible, you should protect the worksheet after you choose 
one of the preceding options.  “Protecting a Worksheet,” in Part 3.
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Double-click the right border of a column heading to automatically set the 
column width to the widest entry in the column. If you select multiple 
column headers and double-click the right border of any one of the column 
headers, each column width is set automatically to the widest entry in the 
column.

Select the column heading(s) of the column(s) you want to adjust. Right-
click the column header(s), choose Column Width from the contextual 
menu, and enter a value in the Column Width dialog box that appears.

  To change the default width of all columns, click the Format button and choose 
Default Width from the menu. This command opens the Standard Width dialog 
box, in which you enter the new default column width. All columns that weren’t 
previously adjusted take on the new column width.

You measure row height in  (a standard unit of measurement in the print-
ing trade; 72 points equal 1 inch). To change the height of one or more rows, 
choose one of the following options:

Select any cell(s) on the worksheets in the row(s) that you want to adjust. 
On the Ribbon’s Home tab, click the Format button, choose Height from 
the menu, and enter a value in the Row Height dialog box that appears.

Drag the bottom border of the row heading with the mouse until the row is 
the height that you want. As you drag, Excel displays a ScreenTip that 
shows the current row height. If you select multiple row headers and drag 
the bottom border of any one of the row headers, all rows adjust 
accordingly.

Select the row heading(s) of the row(s) that you want to adjust. Right-click 
the row header(s), choose Row Height from the contextual menu, and 
enter a value in the Row Height dialog box that appears.

Excel adjusts the row height automatically to accommodate the tall-
est entry in the row.
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If you find yourself continuously applying the same combination of fonts, lines, 
shading, number format, and so on to cells or ranges in your worksheet, using 
cell styles instead will save you time.

Excel provides a Cell Styles gallery with several predefined styles (see Figure 
8-9.) You can modify a predefined style or create a new style from scratch. The 
Cell Styles gallery includes Titles and Headings styles and Themed Cell Styles 
categories that change if you change the workbook theme. The default font used 
for styles in the other predefined categories in the gallery matches the body font 
of the selected theme and therefore changes as the theme changes.  
“Formatting with Themes,” in Part 1.

 

A cell style can include any combination of the following formatting elements:

Number format

Font (type, size, and color)

Alignment (vertical and horizontal)

Border

Pattern

Protection (locked and hidden)

Follow these steps to apply a predefined style:
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Click the Format button. Excel displays the Format Cells dialog box.

Select the appropriate tabs and formatting options you want.

Click OK to exit the Format Cells dialog box and click OK again to close 
the Style dialog box. Excel updates the style in the gallery with the 
changes you made.

If none of the styles available in the Cell Styles gallery meet your needs either 
directly or by modifying a style, you can create a style from scratch. Follow 
these steps to create a custom cell style:

Click the Cell Styles button on the Ribbon’s Home tab, and then choose 
New Cell Style (at the bottom of the gallery). Excel displays the Style 
dialog box.

In the Style Name box, type a name for the style.

Complete Steps 3 to 6 in the section “Modifying an existing style,” 
immediately preceding this section. Excel adds the style to a new Custom 
category section it creates in the Cell Styles gallery.

If you modify existing styles or create several custom styles in a workbook, you 
may want these styles to appear in other workbooks. Merging styles from 
another workbook can save a lot of time because you don’t have to recreate the 
styles manually in every new workbook in which you want to use the styles.

Follow these steps to merge a style from another workbook:

Ensure that the workbook from which you want to merge the styles is 
open.

Activate the workbook you want to merge the styles to.

Click the Cell Styles button on the Ribbon’s Home tab, and then choose 
Merge Styles (at the bottom of the gallery). Excel displays the Merge 
Styles dialog box.

In the Merge Styles From list box, select the workbook from which you 
will be merging the styles and click OK.

Excel asks you to confirm whether you want to merge styles with the 
same names as styles in the workbook that you’re merging to. In most 
cases, you want to click No. Excel merges the styles into the active 
workbook.

To view the merged styles, click the Cell Styles button.
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To insert a vertical page break, follow these steps:

Move the cell pointer to the column where you want to begin the new 
page, but make sure that the cell pointer is in row 1. (Otherwise, you 
insert a horizontal page break  a vertical page break).

Click the Page Layout tab on the Ribbon, click the Breaks button, and 
choose Insert Page Break from the menu. Excel inserts the page break in 
the column to the left of the cell pointer.

  You can often get a better perspective of where to insert breaks in your 
worksheet by creating your page breaks in the page break preview display 
mode.  “Previewing and adjusting page breaks,” later in this section.
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Excel automatically zooms out so that you can see more on-screen. You 
can set the zoom factor to any value that you want by using the zoom con-
trols on the status bar.

If you specify a print area (rather than the entire worksheet), the print area 
appears in white and all the other cells appear in a darker color.

You can adjust a page break by dragging the line that identifies a break 
location.

In this display mode, Excel shows manual page breaks as solid lines and 
automatic breaks as dashed lines.

While you’re previewing the page breaks, you have full access to all Excel 
commands.

 If you increase the amount of information to be printed on a page 
having a manual break, Excel automatically scales the output to fit the page.

A is information that appears at the top of each printed page. A is 
information that appears at the bottom of each printed page.

Headers and footers each have three sections: left, center, and right. You can, 
for example, specify a header that consists of your name left-justified, the work-
sheet name centered, and the page number right-justified.

The easiest way to include a header or footer in your printouts is to add the 
header or footer in the header and footer regions of the page layout view mode 
(see Figure 9-4). Either click the Page Layout View button, on the right side of 
the status bar, or click the Page Layout View button on the Ribbon’s View tab to 
enter the page layout view mode.

The header and footer regions in the page layout view have the following 
characteristics:

The regions appear immediately above and below the worksheet data area.

If the header or footer regions are empty, the center section of each region 
includes a watermark. The header watermark is labeled  
and the footer watermark is labeled 

If you hover the mouse pointer over a header or footer section, Excel 
shades the section to indicate the area that the section covers. Simply 
click in a section to add information.

By default, the same header and footer appears on each page.
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To define a custom header or footer, follow these steps:

Complete Steps 1 to 3 in “Selecting a predefined header or footer,” 
immediately preceding in this section.

Enter the desired information in any or all of the three sections of the 
header or footer; or click any of the eight buttons in the Header and 
Footer Elements group (described in the following table) to enter a special 
code.

  After you click away from the section in which you added a code, Excel 
converts the code to the information that will appear on the printed page.

If you need to format the header or footer text, click the Ribbon’s Home 
tab and select from the available tools in the Font group.

Click anywhere in the worksheet to remove the display of the header/
footer tools on the Ribbon.

The Format Picture button in the Header and Footer Elements group is available 
only if you insert a picture in the header or footer. Clicking this button displays 
the Format Picture dialog box, where you can select options to size, rotate, 
scale, crop, and adjust the picture.

  You can combine text and codes and insert as many codes as you want into 
each section. If the text that you enter uses an ampersand (&), you must enter it 
twice (because Excel uses an ampersand to signal a code). For example, to enter 
the text  into a header or footer, type 

.
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  You can use as many lines as you want in your header or footer section. You 
may have to adjust the top or bottom margin, however, to prevent the header or 
footer from spilling into the worksheet area. Position the mouse pointer where 
you want to add another line or wrap an existing line, and press Enter.

 You insert the header or footer information on any page of your 
document and Excel automatically applies the header or footer to all other 
pages.  “Using multiple headers and footers in your reports,” immediately 
following this section.

Excel provides the following options when specifying headers and footers for 
different pages in your reports:

You can specify a different header or footer for the first page. This option 
is useful, for example, for reports that require a different header or footer 
for a title or table of contents page.

You can specify a different header or footer for odd and even pages. This 
option is useful, for example, if you create book-style reports. If, in addition, 
you specify a first page header or footer, Excel applies the odd page 
header or footer starting from the second page of your report.

Follow these steps to add a separate header or footer to the first page or to add 
separate headers or footers to odd and even pages of your report:

Complete Steps 1 to 3 in “Selecting a predefined header or footer,” earlier 
in this section.

Do one or both of the following:

 • To specify a first page header or footer, select the Different First Page 
check box in the Options group of the Header and Footer Design tab.

 • To specify odd and even page headers or footers, select the Different 
Odd & Even Pages check box in the Options group of the Header and 
Footer Design tab.

Enter the header or footer information for each page as follows:

 • If you specified a separate first page header or footer only, enter 
the first page header or footer information in the first page of your 
document and enter the header or footer information for all subsequent 
pages in the second page of your document.

 • If you specified odd and even headers or footers only, enter the header 
or footer information for all odd pages in the first page of your document 
and enter the header or footer information for all even pages in the 
second page of your document.
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You can change the color of your sparkline and any added elements, and you 
change the sparkline type. Select the sparkline and click the Sparkline Tools 
Design tab on the Ribbon.

The Type group allows you to change the type of sparkline. The choices are 
Line, Column, and Win/Loss.

In the Style group, you can select predefined color styles from the gallery. 
Any highlight element that you turn on in the Show/Hide group appears with 
predefined colors in the Styles group.

If none of the predefined styles are to your liking, you can select a sparkline 
color or weight (or both in the case of a line sparkline) from the Sparkline Color 
menu. You can select the color of various highlight elements by choosing a 
color from the Marker Color menu.

As in a standard Excel chart, sparklines have horizontal and vertical axes, but 
they are normally hidden. Excel provides several axis options that you can use 
with sparklines. Select a sparkline, click the Sparkline Tools Design tab, and then 
click the Axis button to display the following list of options for the sparkline 
horizontal and vertical axes, respectively:

These options allow you to change the default 
behavior of the horizontal axis.

 • By default, Excel uses the General Axis Type. This is equivalent to the 
category axis in a standard Excel chart. Note that all sparklines in a 
group share a  horizontal axis. You don’t actually select a range 
for the general horizontal axis type; the axis is inferred from the data 
range. In Figure 10-2, the column labels in the data range are actual 
dates (not just month or year labels), so they can be used as a horizontal 
axis. Choose Date Axis Type from the menu, click in the dialog box that 
appears, and select the date labels. The difference between the general 
axis and the date axis is as follows: If in Figure 10-2, one or more of the 
month columns were missing, the date axis would show the missing 
months as gaps in the sparkline. With the general axis, there would be 
no gaps in the sparkline.

 • You can display the horizontal axis in the sparkline by choosing Show 
Axis from the menu. The axis is displayed only if at least one negative 
value is in a sparkline data range. The axis is therefore useful for 
showing the zero crossing point in a line-type sparkline.

 • By default, when you select a data range for a sparkline, Excel plots the 
data from left to right or top to bottom. If you want to plot the sparkline 
in the reverse data direction, choose Plot Data Right-to-Left from the 
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Click the Insert tab on the Ribbon and then click the Table button (or 
press Ctrl+L). Excel displays the Create Table dialog box and selects the 
entire contiguous range that includes the active cell pointer.

Click OK. Excel creates the table, applies a default style, and adds a sort 
and filter arrow to the cells in the header row. Excel also displays the 
Table Tools Design tab on the Ribbon.

When you create a table, Excel applies a default style to the table. However, you 
can apply a different predefined style to the table or create a style from scratch. 
You can also apply formatting based on the contents of a cell or table column.

Excel identifies the following specific areas in a table that you can format 
automatically and independently: the header row, data rows, totals row, first 
column, and last column. Follow these steps to apply a new style to a table:

Click any cell in the table and then click the Design tab.

Select a new style from the Table Styles gallery. You can scroll the gallery 
options by clicking the upper (scroll) arrows on the right side of the 
gallery, or you can display a drop-down grid by clicking the arrow below 
the scroll arrows. You can preview a style by hovering the mouse pointer 
over a style. Click a style option to apply a style.

In addition, or as an alternative, to Step 2, you can select style and display 
options from the Table Style Options group. Click to select or deselect the 
appropriate check boxes.

 The styles you apply from the Table Styles gallery are based on the 
theme applied to the workbook. Therefore, if you change the workbook theme, 
both the table style and gallery styles change to match the new theme.  
“Formatting with Themes,” in Part 1.

Formatting a table based on the contents of a cell or column contents (conditional 
formatting) is similar to formatting a non-table cell or range based on the contents 
of the cell or range.  “Formatting Based on the Contents of a Cell or Range,” 
and “Formatting a Range Using Comparative Visualizations,” both in Part 8.

However, note the following when you apply conditional formatting to a table:
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If you apply conditional formatting to an entire column, the formatting for 
the column is automatically extended if you add new rows to the table.

Formatting is applied to a table in the following order: direct formatting 
(for example, formatting you apply from the Font group on the Ribbon’s 
Home tab) appears over table style formatting, and conditional formatting 
appears over direct formatting. For example, if you remove direct formatting, 
any table formatting is still there. Similarly, if you remove conditional 
formatting, any direct formatting is still applied.

When you create a table, by default Excel does not include the totals row. 
However, if you need to total data in your table columns, you can add a totals 
row easily. Make sure that the cell pointer is in the table range, click the Design 
tab, and select the Totals Row check box in the Table Style Options group.

After you click the mouse pointer in a cell of the totals row, Excel adds a 
drop-down arrow to the cell. Clicking the arrow displays a convenient list of 
common functions you can apply (Sum, Average, Count, Standard Deviation, and 
so on). If you want to use a function that is not listed, you can choose the More 
Functions option and select the function in the Insert Function dialog box.

You may need to insert new rows into a table to add data. Also, you may want to 
add a column to perform a calculation based on other columns in the table. 
Excel provides convenient methods for inserting rows and columns. You can 
also delete table rows and columns you no longer need.

Choose one of the following methods to add rows to a table:

To add a row above an existing table row (including the totals row), 
right-click a cell in the existing table row and choose Insert  Table Rows 
Above. If you right-click a cell in the last data row, you can add a row 
above or below the last row.

If you use the Tab key to move to the next column when entering data in a 
row, Excel adds a new row automatically after you press the Tab key in the 

 column of the  data row.
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The table name must be different from any other names you create in the 
workbook and must follow Excel’s name creation rules.  Part 6, 
“Creating and Using Names.”

Column names must be unique within the table, although different tables 
can have the same column names.

If a table name or column name changes, formulas that reference the name 
automatically update to include the new name.

Excel updates table and column name references automatically as rows 
and columns are added to or removed from the table.

The reference that includes the table name and any of its identifiable parts is 
called a . The identifiable parts are also known as .

A structured reference can be unqualified or fully qualified. An 
 does not include the table name. A  must 

include the table name.

You must use a  structured reference when you reference table 
data in a formula that’s outside the table range. Use the following methods to 
reference table data in a formula:

To reference all the data in the table, use the table name, or the table name 
and the  specifier. If you want to sum all the data in a table named 
SalesData, for example, enter

  In the formula,  represents the structured reference.

  Note that the SUM function ignores any text in the structured reference.

To reference the data in a table column, use the table name and a column 
qualifier in the form . For example, if you want 
to sum a column named Quarter1 in a table named SalesData, enter

Other table references are useful for some types of lookup formulas. To refer-
ence an entire table (the header row and all data rows), use the form 

. To reference table headers only, use the form 
. To reference an entire column (header and data) 

use the form . To reference just the 
header text of a column, use .

  If you include a totals row in your table, you can reference a total by using 
the form 
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  You can save time entering table name references in a formula by using the 
Formula AutoComplete feature, which lists the defined table names as you begin 
entering the name in the formula. After you enter a square bracket ([) following 
the table name, the AutoComplete feature lists the available specifiers (#All, 
#Totals, #Data, and so on).  “Entering formulas manually,” in Part 4.

A  (sometimes called a ) is simply a column 
that you add to the table that references table data in a formula. The formula 
references are similar to those in “Referencing table data outside the table,” in 
the preceding section, except you can use an  structured reference 
because the calculated column is part of the table.

Follow these steps to add a calculated column and add a formula:

Add a new column to the table.  “Inserting and Deleting Table Rows 
and Columns,” earlier in this part.

Enter a formula that references the table in any cell of the new column. 
You can enter the formula manually or by pointing with the mouse. For 
example, if you have a table named  and want to calculate the 
difference between the sales figures in the  and  columns, 
enter the following manually:

  Note that after you enter the formula in the column, Excel evaluates the 
formula; that is, Excel uses an  for each row.

  If you instead enter the formula by pointing, Excel qualifies the column refer-
ence with an at sign ( ) and brackets the combined reference. For example:

  To enter the formula by pointing with the mouse, type the equal sign (=), 
point to the Quarter1 column in the  row as the formula you’re entering, 
type the minus sign (–) and point to the Quarter2 column. As you type and 
point with the mouse, Excel completes the formula. See Figure 11-2.

 

  The  character is shorthand for the  specifier and is new 
in Excel 2010.

  Excel uses the  ( ) specifier to evaluate the formula 
using . Either form of the formula (implicit or explicit 
intersection) returns the same result.

After you complete the formula, press Enter. Excel fills the entire column 
with the formula.
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Provide a name for the style in the Name box.

Select an element to format in the Slicer Element list box. Then click 
Format to display the Format Slicer Element dialog box.

Select formatting options from the available tabs. Your choices are Font, 
Border, and Fill.

Click OK to return to the New Slicer Quick Style dialog box. Repeat Steps 6 
and 7 for other slicer elements you want to format.

After you complete your formatting changes, click OK to exit the New 
Slicer Quick Style dialog box. The new style appears in the Custom section 
of the Styles gallery.

  In many cases, you may want to change the format of elements in an existing 
style instead of creating a new style from scratch. In Step 4 of the preceding 
procedure, instead of choosing New Slicer Style, right-click the style you want to 
modify and choose Duplicate from the menu. Excel displays the Modify Quick 
Style dialog box. Continue from Step 5 to select the elements you want to modify.

 You can’t directly change a built-in style, but you can create a 
duplicate of a built-in style and make the changes in the duplicate.

After you create a new slicer for a PivotTable, you can associate the slicer with 
other PivotTables in the workbook. The other PivotTables  share the same 
data source as the original PivotTable. The simplest way to associate a slicer 
with another PivotTable is to create one or more copies of the original 
PivotTable. If you already created multiple copies of a PivotTable before you 
add a slicer, by default the slicer is associated with only the PivotTable you 
used to create the slicer.
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Follow these steps to associate a slicer with another copy of a PivotTable:

Create one or more copies of the PivotTable if you did not already do so. 
 “Copying a PivotTable,” later in this part.

Select the slicer you want to associate with the PivotTable copy or copies.

Click the Slicer Tools Options tab and then click the PivotTable 
Connections button. Alternatively, you can right-click the slicer and 
choose PivotTable Connections from the contextual menu. Excel displays 
the PivotTable Connections dialog box.

In the dialog box, place a check mark in the box next to the name of each 
PivotTable you want to associate with the slicer. The dialog box also dis-
plays the worksheet that contains each PivotTable in the list.

Click OK after you complete your selections.

When you add a numeric field to the values area of a PivotTable, by default 
Excel uses the Sum function to summarize the data. If you add a text field to the 
values area, Excel uses the Count function to summarize the text data. The 
Count function is the only way to summarize text data, but Excel provides several 
alternative options for summarizing numeric data. Use either of the following 
methods to select a different summarization function for a numeric field:

Right-click within the numeric field in the values area of the PivotTable, 
choose Summarize Data By from the contextual menu, and then choose an 
option from the flyout menu. Excel displays the new summary for the 
selected field.

Select any cell within the numeric field in the values area of the PivotTable, 
click the PivotTable Options tab on the Ribbon, click the Summarize Data 
By button, and then choose an option from the menu.

  You can display different summarizations for the same numeric field in the 
PivotTable (for example, Sum and Average). For each new summarization, 
simply drag the field label from the field list in the task pane to the Values box 
(the Values box can have the same field multiple times). Each time you drag the 
field to the Values box, Excel adds the field to the values area of the PivotTable 
using the default summarization. To change the default, use the procedure 
outlined for changing the summarization.
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In the lower half of the dialog box, specify where you want to locate the 
PivotTable and then click OK. If you select the Existing Worksheet option, 
click the Location box and then click the cell in the worksheet that will be 
the upper-left corner of the PivotTable. Excel displays the PivotTable Field 
List task pane and the area on the worksheet that will hold the PivotTable. 
In addition, Excel displays PivotTable tools contextual tabs on the Ribbon.

In the Field List task pane, select the check boxes next to the field labels of 
the fields that you want to include or drag the field labels to the boxes in the 
lower portion of the task pane. These boxes correspond to the label areas in 
the PivotTable where your selected fields will appear (refer to Figure 12-1).

  If you select check boxes, Excel chooses the boxes in the lower portion of 
the task pane to place the field labels based on the following assumptions:

 • Field labels for numeric fields (such as TotalPrice) are placed in the 
Values box.

 • Field labels for non-numeric fields are placed in the Row Labels box.

  To override Excel’s default behavior, drag the field labels from the list in the 
top window to the appropriate boxes in the lower part of the task pane.

  After Excel places field labels in the boxes (or you drag the labels to the 
boxes manually), the field data appears in the appropriate PivotTable label 
areas on the worksheet. By default, field labels in the Values box sum the 
corresponding data that appears in the values area of the PivotTable.

Figure 12-1 demonstrates the hierarchical nature of summarizing data in a 
PivotTable and the relationship between the arrangement of the fields in the 
task pane and the worksheet display.

Excel provides + and – indicators next to each level header on the worksheet, so 
you can quickly expand or collapse a level of detail in the PivotTable summary. 
Furthermore, when you create a PivotTable, Excel displays the PivotTable in a 
Compact view by default. The Compact view is similar to that shown in Figure 
12-1, except field headers (labels) are not displayed. To see the field labels, click 
the drop-down arrow to the right of Row Labels or Column Labels.

 “Modifying a PivotTable’s Structure,” later in this part.

When you create a PivotTable, Excel applies a default style to the PivotTable. 
However, you can apply a different predefined style to the PivotTable or create 
a new style. You can also apply formatting based on the contents of a cell or a 
PivotTable field.
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 • If you select a multiple days grouping and then select another 
grouping (for example, months, quarters, or years), Excel ignores the 
multiple days group because it’s not possible to group across grouping 
boundaries. For example, if you attempt to group by week and by 
month, the weekdays can span across two months, so it’s impossible to 
accommodate both groupings simultaneously.

 • In the dialog box, Excel automatically chooses the starting and ending 
dates for the group based on the range of dates in the PivotTable.

To manually specify the starting date or ending date or both, clear the 
check box next to Starting At or Ending At and enter a new date in the text 
box. For example, if you’re grouping by week and want to ensure that the 
week is grouped from Sunday to Saturday, in the Starting At text box, 
enter the Sunday date prior to Excel’s selected starting date (unless 
Excel’s starting date is Sunday).

Click OK. Excel creates the grouping(s).

 

 

 If your date field covers multiple years and you elect to group by month or 
quarter or both, you should also include the Years grouping. If you don’t include 
the Years grouping, each month or quarter will be summarized for all years, not 
for each year.

If you include a numeric field (or a text field that looks like a number) in the row 
or column areas of the PivotTable, you can create a number group. For example, 
if you have a row field with a lot of order or invoice numbers, you might want to 
create a more compact report. To create a number group, follow these steps:

Right-click a cell in the field in which you want to create a number group 
and choose Group from the menu. Excel displays the Grouping dialog box 
and automatically chooses the starting and ending numbers for the group.
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To manually specify the starting number or ending number or both, clear 
the check box next to Starting At or Ending At and enter a new number in 
the text box.

In the By text box, specify the number that you want to group by.

Click OK. Excel creates the grouping.

Excel allows you to create text groups. A text group might be useful, for exam-
ple, if you want to group multiple states into sales territories. Follow these steps 
to create a text group:

Select the cells in the field that you want to group. If the items that you 
want to group aren’t next to each other, you can make a multiple selection 
by holding Ctrl and then selecting the items that will make up the group.

Right-click any cell in the selection and choose Group from the contextual 
menu. Excel automatically creates the group with a generic title, such as 
Group1, Group2 and so on.

To change the name of the group to something more meaningful, click the 
cell with the new group name and then type a new name in the formula bar.

A PivotTable is a special type of range, and (except for formatting) you can’t 
manipulate it like a normal range. For example, you can’t insert or delete rows, 
edit results, or move cells. If you attempt to do so, Excel displays an error 
message. However, you can make certain modifications to the layout or structure 
of your PivotTable, some of which are described in this section.

When you create a PivotTable, by default Excel uses the new Compact layout, in 
which the row and column field headings are hidden. This layout is useful if you 
have many fields in your report because it minimizes horizontal space on the 
worksheet and can make reading the report easier. You can, however, use one of 
the following alternative layouts:

Outline: This layout is similar to the Compact layout, except it displays the 
individual field headings.

Tabular: In this layout, the first item in a sublevel field appears not on a 
separate row (refer to Figure 12-1) but on the same row as its upper level 
(parent) field item.
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If you’re using the Compact report layout, you must first choose the field 
you want to filter from the Select Field drop-down list. Above the field 
items window, choose the  Filters option (where  is Label, 
Number, or Date, depending on the data type of the field you’re filtering). 
Each row or column field in a PivotTable has either a Value filter and a 
Label filter or a Value filter and a Date filter.

Choose a filter option from the flyout menu.

Complete the dialog box for the filter option and then click OK.

During your analysis of the data in a PivotTable, you may have applied multiple 
filters to one or more fields. You can manually remove the filters one by one, but 
Excel provides a quicker way to remove filters from your PivotTable:

To clear filters from a single field, click the arrow on the field header of the 
field from which you want to remove filters (either on the PivotTable or 
the task pane field list). If you’re using the Compact report layout, click the 
arrow on Row Labels or Column Labels to display the sort and filter 
options. Then choose Clear Filter from , where  is the 
name of the field whose filters you’re clearing (for example, ProductName). 
If you’re using the Compact report layout, you must first choose the field 
from which you want to remove the filters from the Select Field drop-down 
list from the sort and filter options.

To clear all filters in the PivotTable, click anywhere in the PivotTable, click 
the Sort & Filter button on the Ribbon’s Home tab, and then choose Clear 
from the menu.

Filtering data is one of the most common activities performed with a table. 
Often, you want to view or analyze a subset of the data in a large dataset. When 
Excel creates a table, it includes a sort-and-filter drop-down arrow to the right of 
each column header. After you filter your table, the status bar displays the 
number of rows visible.

 You can use Excel’s filtering features in a standard (non-table) range. 
Select the range, click the Sort & Filter button on the Ribbon’s Home tab, and 
choose Filter from the menu to add the Sort & Filter drop-down arrows to the 
header row. A worksheet can have only one sort and filter range but can have 
many tables, each with its own sort and filter settings.
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Immediately above the window that displays individual column entries, 
choose the  Filters option (where  is Text, Number, or 
Date, depending on the data type of the column you’re filtering).

Choose a specific filter option from the flyout menu or choose Custom 
Filter at the bottom of the menu to display a dialog box that offers 
additional options.

If your choice in Step 3 displays a dialog box, complete the dialog box 
options and then click OK.

Excel allows you to filter by cell color. Colors are cell background or font colors 
applied manually or by conditional formatting. Colors can also include color 
scales and icon sets.

 You can filter by only one color at a time.

To filter your table data based on color formatting, follow these steps:

Click the arrow on the header of the column with the color formatting you 
want to filter. Excel displays the sort and filter options.

Choose Filter by Color, and then choose a color option from the flyout 
menu. You can also choose the No Fill option to filter out all cells with 
font or background formatting.

 Colors for filtering do  include colors defined in the table style, so 
your table formatting is preserved after color filtering.

While analyzing data in a table, you may have applied multiple filters to one 
or more columns. You can manually remove the filters one by one, but Excel 
provides a quicker way to remove filters from your table:

To clear filters from a single column, click the arrow on the column header 
of the column from which you want to remove filters. Then, from the sort 
and filter options, choose Clear Filter from , where 

 is the name of the column whose filters you’re clearing (for example, 
ProductName).

To clear all filters in the table, click anywhere in the table, click the Sort & 
Filter button on the Ribbon’s Home tab, and then choose Clear from the 
menu.
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Sorting a PivotTable involves rearranging row or column field items so that 
the items appear in ascending, descending, or a custom order. You may, for 
example, want to sort a row field of customers or sales regions alphabetically. 
You can sort numerically, alphabetically, or by date, depending on the data 
type.

 Unlike a table, Excel sorts items hidden in a filtered field, so that if 
you remove the filter, the field remains sorted.

The following rules apply when you sort a row or column field:

 If you have more than one row or column field in your PivotTable and you 
sort the outermost row or column field, Excel sorts all the other row or 
column fields in ascending order, regardless of the sort order you choose 
for the outermost field.

If you sort the innermost row or column field, Excel does not sort the other 
row or column fields.

If you sort an intermediate row or column field, Excel sorts fields inner to 
that field in ascending order, regardless of the sort order you choose for 
the intermediate field. Excel does not sort fields outer to the intermediate 
field.

In the context of the PivotTable structure, an  row field is any field to the 
right of another field. An  field is any field to left of another field. An  
column field is any field below another field. An  field is any field above 
another field.

Follow these steps to sort a row or column field in your PivotTable using the 
standard sort options:

Click the arrow on the header of the field that you want to sort. If you’re 
using the Compact report layout, individual field headings aren’t shown. 
In this case, click the arrow on Row Labels or Column Labels. Excel dis-
plays the sort and filter options.

If you’re using the Compact report layout, you must first choose the field 
you want to sort from the Select Field drop-down list from the Row Labels 
or Column Labels sort and filter options.

Choose one of the sort direction options at the top of the window. The 
options depend on the data type in the column you’re sorting (numeric, 
text, or date). After you choose an option, Excel rearranges the items in 
the field.
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After you apply a sort to a field, Excel adds a small arrow to the field header 
arrow, indicating the direction of the sort. The arrow also serves as a reminder 
that you’ve applied a sort to the field.

In some cases, you may want to sort based on the data in the values area of the 
PivotTable. For instance, you may want to sort sales numbers from largest to 
smallest.

To sort based on data in the values area, right-click any cell in the value column 
you want to sort, choose Sort from the contextual menu, and then select a sort 
direction from the flyout menu. Excel sorts the items in the innermost row field, 
along with their corresponding values.

You can also sort row-wise instead or column-wise. Right-click any cell in the 
value row you want to sort, choose Sort from the contextual menu, and then 
select More Sort options from the flyout menu. In the Sort by Value dialog box, 
select a sort option (Smallest to Largest or Largest to Smallest) and then select 
Left to Right for the sort direction. Click OK, and Excel sorts the items in the 
innermost column field, along with their corresponding values.

When the standard ascending or descending sort order doesn’t apply for a field, 
you can arrange the field items manually. If you have many items you need to 
arrange manually, it’s better to use a custom sort order.  “Sorting a row or 
column field using a custom sort order,” immediately following this section.

To rearrange an item manually, click the item to select it. Position the mouse 
pointer at the edge of the selection until a black arrow cross is displayed at the 
tip of the pointer. Then hold down the left mouse button and drag the item to its 
new location.

In some cases, you may want to sort a text field in an order other than alphabetical 
ascending or descending. If your data consists of month names, for example, 
you probably want them to appear in chronological date order rather than 
alphabetically. Excel includes four custom lists, and you can also define your 
own. To sort one or more columns by a custom list, follow these steps:

Complete Steps 1–3 in “Sorting a row or column field using standard sort 
options,” except in Step 3, choose More Sort Options instead of one of the 
sort direction options. Excel displays the Sort dialog box. See Figure 13-5, 
left.

Click More Options. Excel displays the More Sort Options dialog box. See 
Figure 13-5, right.
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